
PUBLIC NOTICE 
FEDERAL COMMUNICATIONS COMMISSION 
445 12th STREET, S.W. 

ASHINGTON, D.C. 20554 DA 10-1763 W 
News media information 202/418-0500     Fax-On-Demand  202/418-2830     Internet:  http://www.fcc.gov    ftp.fcc.gov 
 
 
         Released:  September 17, 2010 

 
WIRELESS TELECOMMUNICATIONS BUREAU ANNOUNCES THAT APPLICATIONS  
FOR LOWER AND UPPER PAGING BANDS LICENSES ARE ACCEPTED FOR FILING 

 
Auction 87 

 
Report No. AUC-87 (Auction 87) 
 
 On August 6, 2010, the Federal Communications Commission completed an auction of licenses 
in the lower and upper paging bands spectrum (Auction 87).1  The long-form applications (FCC Form 
601) for the lower and upper paging bands licenses listed in Attachment A have been found, upon initial 
review, acceptable for filing.2  The Commission may return or dismiss any application if it is found, upon 
further examination, to be defective or not in conformance with the Commission's rules.  See 47 C.F.R. § 
1.934(a), (d). 
 
 Petitions to deny the applications listed in Attachment A must be filed no later than September 
27, 2010, ten (10) days after the date of this Public Notice.  See 47 C.F.R. § 1.2108(b).  Oppositions to a 
petition to deny must be filed no later than October 4, 2010, five (5) business days after the filing date for 
petitions to deny.  See 47 C.F.R. § 1.2108(c).  Replies to oppositions must be filed no later than October 
12, 2010, five (5) business days after the filing date for oppositions.  See 47 C.F.R. § 1.2108(c).  All 
pleadings filed regarding lower and upper paging bands long-form applications should refer to Report 
No. AUC-87, as well as to the specific file number of the individual application. 
 
                                                           
1 Auction of Lower and Upper Paging Bands Licenses Closes; Winning Bidders Announced for Auction 87, Public 
Notice, DA 10-1463 (rel. Aug. 12, 2010) (WTB 2010). 
2 Certain applicants failed to file the required FCC Form 601 by August 26, 2010, as required by section 1.2107 of 
the Commission's Rules, 47 C.F.R. § 1.2107(c), and have sought waivers to allow late filing of their FCC Form 601.  
See Burlington Communications Service Center, Inc., File No. 0004371447 (filed Aug. 31, 2010); Communications 
Equipment, File No. 0004371681 (filed Aug. 31, 2010); Gabriel Wireless, LLC, File No. 0004372624 (filed Aug. 
31, 2010); Indiana Paging Network, Inc., File No. 0004372008 (filed Aug. 31, 2010); Itron, Inc., File No. 
0004372435 (filed Aug. 31, 2010); Repeater Network, Inc., File No. 0004371939 (filed Aug. 31, 2010); and TBA 
Communications, Inc., File No. 0004372129 (filed Aug. 31, 2010).  Certain applicants failed to file the required 
FCC Form 602 by August 26, 2010, as required by section 1.2107 of the Commission's Rules, 47 C.F.R. § 1.2107(f), 
and have filed their FCC Forms 602 after that date.  See Bay Electronics, Inc., File No. 0004384415 (filed Sep. 10, 
2010); Chesapeake Operating, Inc., File No. 0004382245 (filed Sep. 8, 2010); KAMO Electric Cooperative, Inc., 
File No. 0004388432 (filed Sep. 14, 2010); and TBA Communications, Inc., File No. 0004382732 (filed Sep. 9, 
2010).  We hereby find that it is in the public interest to waive section 1.2107 of the Commission’s rules, as 
applicable.  Because each of these applicants timely met its down payment requirement and submitted the missing 
form(s) after being notified of the failure to meet the filing deadline, the post-auction licensing process for Auction 
No. 87 was not significantly delayed or materially affected.  Thus, under the circumstances, we believe that grant of 
the waiver requests associated with these FCC Forms 601 and 602 is appropriate, pursuant to sections 0.331 and 
1.925 of the Commission's Rules.  47 C.F.R. §§ 0.331, 1.925. 
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 Submissions may be filed electronically, through the Commission’s Universal Licensing System 
(“ULS”),3 or by paper, pursuant to the instructions below. 
 

• If filed electronically, the ULS website may be accessed at http://wireless.fcc.gov/uls/.  From the 
ULS website, interested parties begin the process of submitting a pleading by clicking on the 
“SUBMIT A PLEADING” link.  The link takes the user first to the Pleadings Information 
Screen.  Upon completion of that screen, clicking “CONTINUE” will take the user to the File 
Numbers/Call Signs Screen.  Upon completing that screen, the user continues to complete the 
third and fourth steps of the process, in the Attach File and Confirmation Screens, respectively.  
Each screen will indicate the information to be supplied and/or the action(s) to be performed for 
completion of that screen.  Additionally, a more detailed description of the instructions can be 
found in the Public Notice announcing the enhancement of ULS to implement electronic filing for 
pleadings.4 

 
 If filed by paper, a party must file an original and four copies of each filing.  Filings can be sent 

by hand or messenger delivery, by commercial overnight courier, or by first-class or overnight 
U.S. Postal Service mail.  All filings must be addressed to the Commission’s Secretary, Office of 
the Secretary, Federal Communications Commission. 

 
 All hand-delivered or messenger-delivered paper filings for the Commission’s 

Secretary must be delivered to FCC Headquarters at 445 12th St., SW, Room TW-
A325, Washington, DC 20554.  The filing hours are 8:00 a.m. to 7:00 p.m.   All hand 
deliveries must be held together with rubber bands or fasteners.  Any envelopes must 
be disposed of before entering the building.   

 
 Commercial overnight mail (other than U.S. Postal Service Express Mail and Priority 

Mail) must be sent to 9300 East Hampton Drive, Capitol Heights, MD  20743. 
 

 U.S. Postal Service first-class, Express, and Priority mail must be addressed to 445 
12th Street, SW, Washington DC  20554. 

 
One copy of each pleading must be delivered electronically, by e-mail or facsimile, or if delivered as 
paper copy, by hand or messenger delivery, by commercial overnight courier, or by first-class or 
overnight U.S. Postal Service mail (according to the procedures set forth above for paper filings), to:  
(1) the Commission's duplicating contractor, Best Copy and Printing, Inc., at FCC@BCPIWEB.COM or 
(202) 488-5563 (facsimile); (2) Michael Connelly, Mobility Division, Wireless Telecommunications 
Bureau, at michael.connelly@fcc.gov, or (202) 418-7224 (facsimile); and (3) Kathy Harris, Mobility 
Division, Wireless Telecommunications Bureau, at kathy.harris@fcc.gov, or (202) 418-7224 (facsimile). 
 
 The applications listed in Attachment A are available to the public for electronic viewing in the 
Commission's Universal Licensing System (“ULS”).  Instructions for accessing and using ULS are 
contained in Attachments B and C of this Public Notice. 
 
  

                                                           
3 The Commission enhanced ULS to implement the electronic filing of pleadings.  See Wireless 
Telecommunications Bureau Enhances the Commission’s Universal Licensing System to Implement Electronic 
Filing for Pleadings, Public Notice, 21 FCC Rcd 424 (WTB 2006) (“ULS Pleadings Implementation PN”). 
4 See ULS Pleadings Implementation PN, 21 FCC Rcd at 425.  
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Any amendments to FCC Form 601 applications must be filed electronically.  For technical 
assistance in using ULS for viewing applications or making amendments to applications, contact the FCC 
Technical Support Hotline at (202) 414-1250, or Denise Walter at (202) 418-0620.  The FCC Technical 
Support Hotline generally will be available Monday through Friday, from 9 a.m. to 6 p.m. ET.  All calls 
to the FCC Technical Support Hotline are recorded.  Questions regarding procedural issues should be 
directed to Michael Connelly at (202) 418-0620. 
 
 
 This Public Notice contains the following attachments: 
 
Attachment A:  List of Applications Accepted for Filing – Sorted by Applicant. 
 
Attachment B: Instructions for Searching for Applications Listed in Attachments A Using ULS.  
 
Attachment C: Instructions for Accessing the FCC Network Using Windows 95/98/2000/XP. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ATTACHMENT A
LOWER AND UPPER PAGING BANDS

APPLICATIONS ACCEPTED FOR FILING 
AUCTION ID: 87

SORTED BY APPLICANT NAME AND FILE NUMBER
DATE OF REPORT: SEPTEMBER 17, 2010

Applicant Name                                    File Number

Intent to Seek a 
Tribal Lands 

Bidding Credit

A BEEP, LLC                                       0004364288 N
A V Lauttamus Communications, Inc.                0004363010 N
Advanced Paging & Communications Inc.             0004365021 N
AMS Spectrum Holdings, LLC                        0004361928 N
AMS Spectrum Holdings, LLC                        0004361933 N
Bay Electronics, Inc.                             0004361415 N
Bay Electronics, Inc.                             0004361418 N
Big Rivers Electric Corporation                   0004366953 N
Blue Ridge Electric Cooperative, Inc.              0004366645 N
Burlington Communications Service Center Inc.     0004371447 N
Busby, Christine M                                0004367438 N
Buttner Holdings, LLC                             0004365200 N
Buttner Holdings, LLC                             0004365239 N
Buttner Holdings, LLC                             0004366141 N
Central Vermont Communications, Inc.              0004363565 N
Centre Communications Inc.                        0004367490 N
Chesapeake Operating, Inc.                        0004366621 N
Chesapeake Operating, Inc.                        0004366632 N
Chesapeake Operating, Inc.                        0004366641 N
Clark Communications                              0004356583 N
Communication specialiostsof Wilmington, LLC      0004361855 N
Communications Equipment Inc.                     0004371681 N
Consumers Energy Company                          0004366933 N
Cook Telecom, Inc.                                0004367194 N
Cook Telecom, Inc.                                0004367212 N
Cook Telecom, Inc.                                0004367215 N
Dallas County Community College District          0004366365 N
Day Management Corporation                        0004367754 N
Diverse Power Inc.                                0004367200 N
Diverse Power Inc.                               0004367221 N
Diverse Power Inc.                                0004367235 N
ELECTRONIC ENGINEERING CORPORATION            0004356205 N
ELECTRONIC ENGINEERING CORPORATION            0004356225 N
ELECTRONIC ENGINEERING CORPORATION            0004356242 N
Emergency Radio Service, Inc.                     0004364592 N
FLA Lic, LLC                                      0004364189 N
FleeTALK Partners, Ltd                            0004364601 N
Futronics Paging, Inc.                            0004367271 N
Gabriel Wireless, LLC                             0004372624 N
Guller, Steven J                                  0004367648 N
Holesworth, William A                             0004363480 N
Indiana Paging Network, Inc.                      0004367269 N
Indiana Paging Network, Inc.                      0004372008 N
Intelligent Transportation & Monitoring Wireless LLC 0004367969 N
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ATTACHMENT A
LOWER AND UPPER PAGING BANDS

APPLICATIONS ACCEPTED FOR FILING 
AUCTION ID: 87

SORTED BY APPLICANT NAME AND FILE NUMBER
DATE OF REPORT: SEPTEMBER 17, 2010

Applicant Name                                    File Number

Intent to Seek a 
Tribal Lands 

Bidding Credit
Intelligent Transportation & Monitoring Wireless LLC 0004367970 N
Intermountain Rural Electric Association          0004367666 N
Itron, Inc.                                       0004372435 N
Jenkins, Micheal H                                0004353599 N
Jenkins, Micheal H                                0004353604 N
Jenkins, Micheal H                                0004353613 N
Jenkins, Micheal H                                0004353617 N
Jenkins, Micheal H                                0004357323 N
KAMO Electric Cooperative, Inc.                   0004366162 N
KTI, Inc.                                         0004363868 N
Lincoln Communications, Inc.                     0004367140 N
MacIntyre, Scott C                                0004360397 N
Minnesota Mobile Telephone Company                0004366467 N
Mountain Communications and Electronics, Inc.     0004366806 N
New York State Electric & Gas Corporation         0004366594 N
PacifiCorp                                        0004366820 N
PHI Service Company                               0004366656 N
ProPage, Inc.                                     0004361946 N
Repeater Network LLC                              0004371939 N
Schuylkill Mobile Fone, Inc.                      0004367379 N
Serv-Quip LP                                      0004363169 N
Sherman, Arthur N                                 0004367195 N
Silke Communications, Inc.                        0004355886 N
Skybridge Spectrum Foundation                     0004367978 N
Skybridge Spectrum Foundation                     0004367981 N
Skybridge Spectrum Foundation                     0004367986 N
TBA Communications, Inc.                          0004372129 N
Tittle, Thomas W                                  0004367158 N
Triangle Communications, Inc.                     0004367248 N
Tri-State Generation and Transmission Association, Inc 0004367671 N
Tri-State Generation and Transmission Association, Inc 0004367667 N
TTP Licenses, Inc.                                 0004366694 N
Two Way Communications                            0004359102 N
V2G LLC                                           0004367971 N
V2G LLC                                           0004367975 N
V2G LLC                                           0004367982 N
Wireless Ventures, LLC                            0004367728 N
WISCONSIN, STATE OF                               0004357845 N
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Attachment B 
 

SEARCH INSTRUCTIONS FOR BROADBAND PCS APPLICATIONS 
      

This attachment provides instructions for electronically searching the FCC Network for a 
specific application or applications on file with the Commission.  The following instructions 
relate specifically to searching for applications filed in response to Auction 87. 
 
To search the FCC Network for an application, you must first connect to the FCC Network.  
Attachment C describes how Windows 95/98/2000/XP users can connect to the FCC Network 
using the Dial-Up Networking features of Windows 95/98/2000/XP. 
 
We recommend that you use Netscape Communicator 6.2 or higher, or Internet Explorer 5.5 or 
higher (Internet web browser software) to use ULS for license searches.  To download the latest 
versions of Netscape Communicator or Internet Explorer free of charge, access the Netscape 
download site at http://home.netscape.com/download/, or the Microsoft Internet Explorer 
download site at: http://www.microsoft.com/windows/ie/downloads/default.asp. 
 
 

Conventions 
 
The instructions in this attachment use the following typographic conventions: 
 
bold  Represents objects on the screen that you click with the mouse pointer, including 

buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link, 
Save option in the File menu). 

 
italic  Represents field names or areas of a screen (e.g., Licensee Name field, Applicant 

Information area of a screen). 
 
bold italic Represents characters that you must type exactly as they appear in the 

instructions.  For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are printed. 

 
SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC). 
 
Note:  Throughout these instructions, “enter” means to type the appropriate information and then 
press the ENTER key. 

http://home.netscape.com/download/
http://www.microsoft.com/windows/ie/downloads/default.asp
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Performing an Application Search 
 
Once you have connected to the FCC Network, follow the procedures below to search for an 
application.  You may click the ? (Help) button at anytime for additional information on using 
Application Search. 
 
1. Connect to the FCC Network using one of the following options: 
  
 Note:  If your PC is connected to a network, you must use a secure proxy to access the 

FCC Network.  Consult your Network Administrator. 
 
 Dial-Up Access 
 
 a. Use Dial-Up Networking in Windows 95/98/2000/XP to connect to the FCC 

Network (see Attachment C). 
 
 b. Start your web browser.  In the location field of the web browser screen, type 

http://wtbwww05.fcc.gov.  Then press the ENTER key.  
 
 Internet Access 
 
 a. Start your web browser and connect to the Internet using your Internet Service 

Provider. 
 
 b. In the location field of the web browser screen, type http://wireless.fcc.gov/uls/.  

Then press the ENTER key.  
 
2. Verify that Java and JavaScript are enabled in your web browser preferences.  

Additionally, the preferences must specify “Accept all cookies.”  Refer to your web 
browser Help facility for more information. 

  
3. On the Universal Licensing System main page, click the Applications button, located in 

the center of the page.  
  
4. For a quick search, use the drop down list in the center License Search box to search by a 

specific Call Sign, FRN or Licensee Name.   You can choose the Advance Search option 
to search by various criteria.   

  
 You can conduct an Advanced Application Search to specify search options by Applicant 

State, ZIP, and Name; Dates (Receipt, Action, etc.); Application Status; Application 
Purpose; and more. 

 
 Also shown are the options for various Non-Auction service specific searches:  Aircraft, 

Amateur, Commercial/Restricted Permits, GMRS and Ship.    
 
 You have the option to conduct a Specialized Search with the following options:   
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• Select Market Based to search only for licenses associated with an FCC Auction 

 
• Select Site Based to search only for site-based licenses 

 
• Select Frequency to search for Wireless licenses based on a single frequency or 

frequency ranges. 
 

• Select Facility ID to search by facility identification number. 
 

• Select Geographic to search by coordinates, county/state, address, and frequency 
information. 

 
• Select Link Registration ID to search by the link registration identification number. 

 
• Select NG Number to search by the Interdepartment Radio Advisory Committee 

(IRAC) coordination number. 
 

• Select Transfers and Assignment Search by search by Assignment information 
transfer information, date information and more. 

 
• Select Ownership Search to search by Ownership Disclosure Filings by Filing Type, 

Filing Status and more. 
 
  
5. The appropriate Application Search screen appears.  This screen contains several data 

entry fields used for specifying the criteria for your application search.  Specify the 
search criteria necessary to locate the desired application.  Please refer to the following 
“Basic Guidelines for Specifying Search Criteria” for more information.   

 
 If you are searching for an application filed for Auction 87, click 87 in the Auction ID 

field. 
 
 Basic Guidelines for Specifying Search Criteria: 
 
 • You must specify search criteria in at least one field.  You do not have to specify 

search criteria in all of the search fields.  Enter search criteria into as many fields 
as you wish. 

 
 • To specify search criteria in a search field containing a menu of options, click the 

desired option from the menu.  Use the scroll bars to view all options in a menu.  
You can select multiple options from a menu by pressing the CTRL key while you 
click the menu options.  
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 • Click the Reset button to undo a menu selection and search for all options in the 
menu.  

 
 • Click the Clear button to reset entries in all of the search fields.   
 
 Click the ? Help button for a definition of each search field available on the Application 

Search screen. 
 
6. After you have specified the desired search criteria, click the Search button.  The system 

will scan the database for any applications matching the search criteria.  The matching 
application files will be listed on the Search Results screen.  The Search Results screen 
will identify the file number, licensee name, application purpose, application status, radio 
service code, and receipt date for each application returned in the query. 

 
 A message on the Search Results screen will indicate if no matches were found for the 

specified search criteria.  Click the New Search button and re-specify search criteria. 
 
7. To view an application, click its file number link.  To navigate through the data on the 

Application screen, use the scroll bar or click the links at the top of the screen.  Click the 
? Help button for information regarding specific functions available on this screen. 

 
 • To re-access the Search Results screen, click Return to Results at the top of the 

screen. 
 
 • To begin a new search, click New Search at the top of the screen.. 
 
 

Technical Support 
 
For technical assistance in searching the ULS for applications, contact the FCC Technical 
Support Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY).  The FCC Technical 
Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All 
calls to the FCC Technical Support Hotline are recorded. 
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Attachment C 
 

USING DIAL-UP NETWORKING IN 
WINDOWS 95/98/2000/XP FOR ULS FILING 

 
This attachment describes how to use Windows 95/98/2000/XP Dial-Up Networking to establish a 
direct connection from your PC to the FCC Network and the Universal Licensing System (ULS) in 
order to file or review the Form 601.  This point-to-point connection is not routed through the 
Internet.  
 
This direct dial-up connection is NOT required to perform ULS online filing. You may file or review 
Form 601 on the Internet by entering http://wireless.fcc.gov/uls in your Web browser’s 
address/location bar and clicking the Online Filing button on the ULS homepage. 
 
 

Conventions 
 
The instructions in this section use the following typographical conventions: 
 
bold  Represents objects on the screen that you click with the mouse pointer, including 

buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, 
Save option in the File menu). 

 
italic  Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses 

area of a screen). 
 
bold italic Represents characters that you must type exactly as they appear in the instructions.  

For example, if you are instructed to type http://wireless.fcc.gov/uls, you should 
type all of the characters shown in bold italic exactly as they are printed. 

 
SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC). 
 
Note:  Throughout these instructions, “enter” means to type the appropriate information and then 
press the ENTER key. 
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Hardware and Software Requirements 

 
Connecting to the FCC Network using Windows 95/98/2000/XP Dial-Up Networking requires at a 
minimum the following hardware and software: 
 
Hardware Requirements 
 
• CPU: Pentium 133 or above 
• RAM:  32 MB (more recommended if you have multiple applications open) 
• Monitor:  VGA or above 
• Modem: 28.8 Kbps, Hayes-compatible or faster (recommend 56.6 Kbps) 
• Mouse or other pointing device 
 

Software Requirements 
 
• Web browser software is required. You may use Netscape Communicator (v. 4.5, 4.51, 4.61, 4.7x) or 

Internet Explorer (v. 5.5 or later) browser software to electronically register and file FCC Form 601 
through ULS. You can download Netscape Communicator free of charge by accessing the Netscape 
download site at http://home.netscape.com/download/archive.html. You may also download Internet 
Explorer at http://www.microsoft.com/windows/ie/downloads/default.asp. 

 
• Microsoft Windows 95/98/2000/XP 
 

Note:  If you are running Windows in a networked environment, check with your local network 
administrator for any potential conflicts with Windows 95/98/2000/XP Dial-Up Networking.  
This usually includes any TCP/IP installed network protocol.   

 
• Adobe Acrobat 4.0 Reader (or higher) is recommended as a plug-in to your browser.  This 

provides a viewer for displaying files related to applications, such as attachments and exhibits. 
For best results, install the plug-in after you have installed the desired web browser. This will 
allow the plug-in to be fully integrated within the browser window. 

 
To download Adobe Acrobat version 4.0 or higher, access the Acrobat download site at 
http://www.adobe.com/support/downloads/main.html. 
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Configuring Dial-Up Networking 

 
1. To start dial-up networking in Windows 95/98: 
 

a. Click the Windows 95/98 Start button.   
b. Click the Programs option to display the Programs menu. 
c. Click the Accessories option to display the Accessories menu. 
d. In Windows 95, click Dial-Up Networking. 

In Windows 98, click Communications, then Dial-Up Networking. 
 

If Dial-Up Networking is not an option on your Accessories menu, you should install it from 
your Windows 95/98 CD or diskettes. 
 
To start dial-up networking in Windows XP follow the steps below:  
a. Click the Start button. 
b. Click the Programs option to display the Programs menu. 
c. Click the Accessories option to display the Accessories menu. 
d. Click Communications 
e. Click New Connection Wizard. 
f. Click Connect to the Network at My Workplace. 
g. Click Dial-Up Connection. 
h. Specify connection name by entering the name of the dial-up location in the Company 

Name field, e.g. “FCC Dial-Up Connection.” 
i. Enter dial-up phone number, 1-800-844-2784. 
j. Select Connection Availability: 

Anyone’s use 
My use only 

 
To start dial-up networking in Windows 2000, the user must be logged in as an 
“administrator.” Follow these steps: 
 
a. Click the Start button. 
b. Click Settings. 
c. Click on the Network icon. 
d. Click on Dial-up Connections. 

 
NOTE: You must have administrative rights in Windows 2000 or XP to set up dial-up 
networking. 
 
2. When the Dial-Up Networking window appears, double-click the Make New 

Connection icon. 
 

The Make New Connection window appears. 
 
3. In the field entitled Type a name for the computer you are dialing, type ULS at FCC.  
 
4. In Windows 95, click the down arrow at the right of the Select a modem field and select your 

modem from the menu of available modems.   
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In Windows 98, click the down arrow at the right of the Select a device field and select your 
modem from the menu of available devices. 

 
If your modem does not appear on this list, you must install your modem driver according to 
the modem manufacturer installation procedures, which are usually described in your 
modem’s user manual. 

 
5. Click the Configure button.  Click the Options tab at the top of the Properties window. 
 
6. In the Connection control area of the Options tab, verify that neither option is selected.  If 

either option is selected, click the check box at the left of the option to deselect it.  Then 
click the OK button. 

 
7. Click the Next button.   
 
8. Type 800 in the Area Code field and 844-2784 in the Telephone Number field.  Verify that 

the correct country is selected in the Country code field.  If necessary, click the down arrow 
at the right of the Country code field, and select the appropriate country from the menu of 
available countries. 

 
9. Click the Next button. 
 
10. Click the Finish button.  An icon titled ULS at FCC appears in the Dial-Up Networking 

window. 
 
11. Verify that properties are configured correctly before attempting a dial-up session.  Position 

the mouse pointer on the ULS at FCC icon and click the right mouse button to display a 
menu.  Select Properties from the menu. 

 
12. Click the Server Types tab at the top of the Properties window. 
 
13. In the Advanced Options area, verify that only Enable software compression is selected.   
 

If it is not selected, click the check box at the left of the option to select it.  If either of the 
other options is selected, click the check box to deselect it. 

 
14. In the Allowed Network Protocols area, verify that only TCP/IP is selected.   
 

If it is not selected, click the check box at the left of the option to select it.  If either of the 
other options is selected, click the check box to deselect it. 

 
15. Click the TCP/IP Settings button.  In the TCP/IP Settings window, confirm that the Server 

assigned IP address option is selected.  Then, in the section beneath, select Specify name 
server addresses. 
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16. Type 192.104.54.1 as the Primary DNS.   
 

Make sure that these two options are checked: 
 
• Use IP header compression 
• Use default gateway or remote network 

 
17. Click OK on the TCP/IP Settings window and the Server Type window. 
 
18.     a. Click the Windows 95/98 Start button, then click the Settings option to display the 

Settings menu.  
 

b. Click Control Panel and then double-click the Network icon. 
 

c. In the Configuration tab of the Network window, select TCP/IP and click the 
Properties button.  (If there are multiple TCP/IP protocols, select TCP/IP, then highlight 
Dial-Up Adapter and click Properties.) 

 
d. Click the DNS Configuration tab.  

 
e. Select Enable DNS.  Type bidder in the Host box, type fcc.gov in the Domain box, then 

type 192.104.54.1 in the DNS Server Search Order box and click the Add button.  
 

f. Click OK on the TCP/IP Properties windows, then click OK on the Network window.  
 

g. If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up 
Procedure. 

 
Dial-Up Procedure 

 
1. If the Dial-Up Networking window is not currently open, do the following: 
 

a.  Click the Windows 95/98 Start button.   
b.  Click the Programs option to display the Programs menu. 
c.  Click the Accessories option to display the Accessories menu. 
d.   In Windows 95, click Dial-Up Networking 

In Windows 98, click Communications, then Dial-Up Networking.   
 

The Dial-Up Networking window appears.   
 
2. Double-click the ULS at FCC icon in the Dial-Up Networking window. 
 
3. Click the Connect button on the window.  Do not enter User name and Password. 
 

The Connecting window appears, indicating the status of your connection as your modem dials 
into the system.  This window must remain running during your dial-up session.  You may 
minimize the window, if you wish. 

 
If your modem fails to establish a connection, please see the Troubleshooting section below. 
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4. Once the connection is established, open your Web browser.   
 
5. In your browser’s location field, enter http://wireless.fcc.gov/uls/ 
 

If nothing appears in your Web browser, see the Troubleshooting section below. 
 
6. When you have finished, exit the Web browser, then click the Disconnect button on the 

Connecting window to end your dial-up session. 
 

Troubleshooting 
 
Following are problems you may encounter and possible solutions for resolving or isolating them. 
 
Modem does not respond 
 
1. Confirm that all physical connections for the modem are present. 
 
2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial 

tone. 
 
3. Confirm that the correct modem driver is installed for your modem.  
 
 
Modem dials but does not connect 
 
1. Confirm that the number the modem is dialing is correct. 
 
2. Confirm that the modem prefix, if any, is correct. 
 
 
Modem dials and connects, but nothing appears when you enter the location in the Web 
browser   
 
1. Check the settings in your dial-up networking icon, particularly that the Primary DNS is 

192.104.54.1 and that TCP/IP is the only selected protocol. 
 
2. Confirm that your Web browser is not using proxies; it should be set to “direct connection to 

the Internet.” 
 
3. If you do log into a TCP/IP LAN, confirm that your LAN network IP address is being released. 

  
 

To do so, connect to the FCC Network using dial-up networking, then click the Start button in 
Windows 95/98 and select Run.  Type winipcfg and press OK.  If your IP address does not 
begin with “192.104.”, then your LAN IP address is not being released.  Click the Release All 
button, or consult your LAN administrator. 
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Receive an Internal Server error in the Web browser  
 
1. Confirm that the address entered in the location field is correct (http://www.fcc.gov/wtb/uls). 
 
2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is 

set to Accept All. 
 
 
 
 

Help 
 
For technical assistance with installing or using FCC software, contact the FCC Technical Support 
Hotline at (202)-414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is 
available Monday through Friday from 8 a.m. to 6 p.m. Eastern Time. There are no weekend hours 
and the hotline is closed all Federal holidays.  All calls to the FCC Technical Support Hotline are 
recorded. 
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